
How to Add Surface Finish Symbol in
AutoCAD?

Description

In AutoCAD, adding surface finish symbols is a crucial aspect of technical drawings. These symbols
provide valuable information about the desired texture or appearance of a surface. Whether you’re a
mechanical engineer, designer, or drafter, understanding how to add surface finish symbols in
AutoCAD can enhance the clarity and precision of your drawings. This article will guide you through the
process step by step, ensuring you have the necessary knowledge to incorporate surface finish
symbols effectively.

Adding Surface Finish Symbols in AutoCAD

To add a surface finish symbol in AutoCAD, you can follow these steps:

1. Open AutoCAD: Launch the AutoCAD application on your computer. If you don’t have it
installed, visit the official Autodesk website and download the appropriate version for your
operating system.

2. Create a New Drawing: Start a new drawing or open an existing one where you want to add the
surface finish symbol.

3. Access the Surface Finish Symbol Library: AutoCAD provides a built-in library of standard
symbols, including surface finish symbols. To access this library, click on the “Annotate” tab in
the AutoCAD ribbon menu.

4. Find the Surface Finish Symbol: In the “Annotate” tab, look for the “Surface” panel or a similar
section. This panel contains various tools and options related to annotations and symbols. Locate
the surface finish symbol, which is typically represented as a small square with additional
markings to denote the specific finish type.

5. Insert the Surface Finish Symbol: Once you’ve found the surface finish symbol, click on it to
select it. Then, place the symbol in your drawing by clicking on the desired location. You can
adjust the size and orientation of the symbol using the handles that appear after insertion.
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6. Specify Surface Finish Parameters: After inserting the symbol, you can modify its properties to
specify the desired surface finish. Right-click on the symbol and select “Properties” from the
context menu. In the properties dialog box, you can set parameters such as finish type,
roughness value, and other relevant details.

7. Save and Print: Once you have added and customized the surface finish symbol, save your
AutoCAD drawing. You can then print it or export it in a desired format for further use or sharing.

Types of Surface Finish Symbols

Surface finish symbols in AutoCAD can represent various types of finishes. Some commonly used
symbols include:

Roughness Symbol (Ra): This symbol represents the average roughness of a surface. It
typically consists of the capital letter “R” followed by a value indicating the roughness in
micrometers (?m).
Surface Roughness Symbol (Rz): The Rz symbol denotes the maximum peak-to-valley height
of a surface. It comprises the letter “Rz” followed by a value, also in micrometers.
Machining Symbol (M): The machining symbol represents the manufacturing process used to
create the surface finish. It can include letters such as “G” for grinding, “M” for milling, or “T” for
turning.
Surface Texture Symbol (Smiley): This symbol is often used to represent a specific surface
texture or appearance, such as a smiley face for a polished surface or a rough texture for grip.
Welding Symbol (W): In certain drawings, the surface finish symbol may indicate a welded joint.
The welding symbol consists of a flag-like shape with additional markings to specify the welding
process.

Best Practices for Using Surface Finish Symbols

When adding surface finish symbols in AutoCAD, consider the following best practices:

1. Standardization: Follow industry standards and guidelines when selecting and using surface
finish symbols. Different industries and countries may have specific standards, such as ISO,
ASME, or DIN, which define the symbol conventions.

2. Clear Labeling: Ensure that each surface finish symbol is appropriately labeled and
accompanied by any necessary annotations or callouts to provide additional information or
context.

3. Consistency: Maintain consistency throughout your drawings by using the same symbol for
similar surface finishes. This consistency helps in quickly understanding the intended surface
quality.

4. Legibility: Choose surface finish symbols that are easily readable and scaled appropriately for
the drawing. Avoid overcrowding or overlapping symbols, which can lead to confusion.

5. Documentation: Document the meaning of each surface finish symbol in a drawing legend or
key. This ensures that anyone who views the drawing can easily understand the intended surface
finish specifications.
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FAQ

1. How do you type the surface finish symbol?

To type the surface finish symbol in AutoCAD, you can use the following steps:

1. Start by activating the Text tool in AutoCAD by clicking on the “Text” icon in the Home tab or
using the shortcut command “Text” or “DTEXT.”

2. Position the cursor where you want to insert the symbol in your drawing.
3. Depending on the symbol you want to insert, you have a few options: 

For common surface finish symbols like Ra or Rz, you can type “R” and “Z” followed by the
desired value using the text editor.
For other symbols, such as smiley faces or welding symbols, you can use special
characters available in the AutoCAD text editor. To access these special characters, click
on the “Symbol” button in the text editor dialog box and select the desired symbol.

4. Once you have typed the surface finish symbol, you can adjust its size, position, and formatting
properties using the text formatting options in the text editor.

2. How do I add surface texture in AutoCAD?

In AutoCAD, you can represent surface texture using various methods, including hatch patterns and
custom linetypes. Here’s how you can add surface texture:

1. Start by opening your AutoCAD drawing or creating a new one.
2. Access the “Draw” or “Home” tab in the AutoCAD ribbon menu and locate the “Hatch” tool.
3. Click on the “Hatch” tool to open the Hatch and Gradient dialog box.
4. In the dialog box, you can choose from a variety of predefined hatch patterns or create custom

ones.
5. Select the desired hatch pattern that represents the surface texture you want to add.
6. Specify the boundaries of the area where you want to apply the hatch pattern. You can select

existing closed objects or create new closed boundaries using drawing tools like the “Polyline” or
“Rectangle” command.

7. Adjust the scale and angle of the hatch pattern to achieve the desired surface texture
representation.

8. Click “OK” to apply the hatch pattern and represent the surface texture in your AutoCAD drawing.

3. How do I insert a symbol in AutoCAD?

To insert a symbol in AutoCAD, you can follow these steps:

1. Open your AutoCAD drawing or create a new one.
2. Access the “Insert” tab in the AutoCAD ribbon menu.
3. Click on the “Insert” tool to open the Insert dialog box.
4. In the dialog box, browse to the location where the symbol file is saved on your computer.
5. Select the symbol file and click “Open.”
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6. After opening the file, AutoCAD will prompt you to specify the insertion point in the drawing. Click
on the desired location to insert the symbol.

7. You can use the handles that appear after insertion to adjust the size, rotation, and scale of the
symbol if necessary.

8. Once you’re satisfied with the position and properties of the inserted symbol, save your AutoCAD
drawing to retain the changes.

4. How do I insert a level symbol in AutoCAD?

To insert a level symbol in AutoCAD, you can use the following steps:

1. Open your AutoCAD drawing or create a new one.
2. Access the “Annotate” or “Insert” tab in the AutoCAD ribbon menu.
3. Look for the “Symbol” or “Block” tools within the tab.
4. Click on the tool that allows you to insert predefined symbols or blocks.
5. In the dialog box that appears, search for the level symbol by either browsing through the

available symbols or using a search function if available.
6. Once you locate the level symbol, select it and click “OK” or “Insert” to proceed.
7. Specify the insertion point in your drawing where you want to place the level symbol.
8. Adjust the size, rotation, and scale of the symbol using the handles that appear after insertion, if

required.
9. Save your AutoCAD drawing to retain the changes made.

5. What are the types of surface finishes?

There are various types of surface finishes used to denote the texture or appearance of a surface.
Some common types of surface finishes include:

Roughness: It indicates the irregularities or deviations from the ideal surface.
Smooth: Represents a polished or glossy surface with minimal irregularities.
Matte: Refers to a non-reflective surface with a dull appearance.
Brushed: Depicts a surface with parallel brush strokes or grain pattern.
Etched: Shows a surface that has undergone a chemical or acid treatment.
Textured: Indicates a surface with intentional patterns or designs.
Polished: Represents a surface that has been polished to a high degree of smoothness.
Satin: Depicts a surface with a soft and smooth appearance.
Grooved: Shows parallel or intersecting grooves on the surface.
Patterned: Indicates a surface with repeated decorative patterns.

These are just a few examples, and there can be numerous other types of surface finishes based on
the specific requirements and manufacturing processes involved.

6. What is N7 surface finish?

N7 is a term used to denote a specific level of surface finish based on the machining process. It is a
parameter that indicates the average roughness value (Ra) of a surface in microinches (µin) or
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micrometers (µm). N7 is commonly associated with metalworking processes, such as milling or turning.

The N7 surface finish specification represents a moderate level of smoothness, with a relatively low
roughness value. It indicates a surface with fewer irregularities and a smoother appearance compared
to rougher finishes like N9 or N12.

When designing or specifying a surface finish using N7, it is important to consider the specific industry
standards and guidelines that define the acceptable range of Ra values and the corresponding
manufacturing processes required to achieve the desired surface quality.

7. What is surface finish in machining?

In machining, surface finish refers to the texture, smoothness, and quality of a surface after it has been
machined. It is an important aspect of the manufacturing process, as it affects the functionality,
appearance, and performance of the machined part.

Surface finish in machining is typically measured using parameters such as average roughness (Ra),
root mean square roughness (Rq), or maximum peak-to-valley height (Rz). These parameters quantify
the deviations or irregularities from an ideal flat surface and provide information about the overall
smoothness and texture of the machined surface.

Achieving the desired surface finish in machining involves selecting appropriate cutting tools,
optimizing machining parameters (e.g., cutting speed, feed rate), controlling the tool path, and using
suitable cutting fluids or lubricants. The choice of machining process, tooling, and material also plays a
significant role in determining the surface finish quality.

8. How do you measure roughness?

The measurement of surface roughness is essential to assess the quality and conformity of a surface
finish. In AutoCAD, surface roughness is typically measured using parameters such as average
roughness (Ra) or root mean square roughness (Rq). Here’s how you can measure roughness in
AutoCAD:

1. Open your AutoCAD drawing or create a new one.
2. Access the “Analyze” or “Inspect” tab in the AutoCAD ribbon menu.
3. Look for the “Surface Analysis” or “Geometry Analysis” tools within the tab.
4. Click on the tool that allows you to analyze the surface roughness.
5. Specify the surface or region of interest by selecting the appropriate entities or boundaries in your

drawing.
6. Once you have selected the desired area, AutoCAD will calculate the roughness parameters and

display them in the analysis results.
7. The results will typically include parameters such as Ra, Rq, Rz, or other roughness indicators,

depending on the specific analysis tool used.
8. You can further customize the analysis settings, such as the sampling length or filtering options,

to refine the roughness measurement.
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9. What are the tools of AutoCAD?

AutoCAD offers a wide range of tools and features that enable efficient drafting, modeling, and design.
Some of the essential tools available in AutoCAD include:

Draw Tools: These tools allow you to create basic geometric shapes such as lines, circles, arcs,
polygons, and splines.
Modify Tools: With these tools, you can edit and modify existing objects, including commands
like Move, Copy, Rotate, Scale, Trim, and Extend.
Dimensioning Tools: These tools enable you to add dimensions and annotations to your
drawings, ensuring accurate measurements and clear communication of design intent.
Layer Tools: AutoCAD’s layer management tools help you organize your drawing elements by
assigning them to different layers, controlling visibility, and applying properties like color and
linetype.
Block Tools: Blocks allow you to create reusable objects or components that can be inserted
into multiple drawings. AutoCAD provides tools to create, modify, and manage blocks efficiently.
Hatch Tools: The hatch tools enable you to add patterns or solid fills to enclosed areas,
representing materials or surface textures.
Annotation Tools: AutoCAD offers a variety of annotation tools for adding text, dimensions,
leaders, tables, and symbols to your drawings.
3D Modeling Tools: These tools facilitate the creation of three-dimensional objects, including
commands for extruding, revolving, lofting, and filleting.
View Tools: AutoCAD provides tools for manipulating and controlling the display of your
drawings, including commands to zoom, pan, rotate, and navigate through 3D space.
Plotting and Printing Tools: These tools allow you to configure and customize the plotting and
printing settings of your drawings, ensuring accurate representation on paper or digital formats.

These are just a few examples of the many tools available in AutoCAD, each serving specific purposes
to streamline the drafting and design process.

10. How do I add electrical symbols in AutoCAD?

To add electrical symbols in AutoCAD, you can follow these steps:
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1. Open your AutoCAD drawing or create a new one.
2. Access the “Insert” or “Block” tab in the AutoCAD ribbon menu.
3. Look for the “Insert” or “Insert Block” tool within the tab.
4. Click on the tool to open the Insert dialog box.
5. In the dialog box, navigate to the location where the electrical symbol file is saved on your

computer.
6. Select the symbol file and click “Open” or “Insert” to proceed.
7. AutoCAD will prompt you to specify the insertion point in your drawing. Click on the desired

location to insert the electrical symbol.
8. Adjust the size, rotation, and scale of the symbol using the handles that appear after insertion, if

necessary.
9. Save your AutoCAD drawing to retain the changes made.

You can find electrical symbol libraries or blocks specific to electrical design in AutoCAD from various
online sources or by using specialized AutoCAD add-ons or plugins.

11. How do you type a diameter symbol?

To type a diameter symbol (Ø) in AutoCAD, you can use one of the following methods:

1. Using the Keyboard: Press and hold the “Alt” key on your keyboard while entering the Unicode
value “0216” using the numeric keypad. Release the “Alt” key, and the diameter symbol (Ø) will
appear.

2. Using the Character Map: Open the Windows Character Map utility by typing “Character Map” in
the Windows search bar. In the Character Map, locate the diameter symbol (Ø), select it, and
click on the “Copy” button. Then, in AutoCAD, use the “Paste” command (Ctrl+V) to insert the
symbol into your drawing.

3. Using AutoCAD’s Symbol Menu: In AutoCAD, click on the “Symbol” button within the text editor
dialog box. In the Symbol menu, locate the diameter symbol (Ø) and click on it to insert it into
your drawing.

Regardless of the method you choose, you can adjust the size and formatting properties of the
diameter symbol using the text formatting options available in the AutoCAD text editor.

12. How do I add a curly bracket in AutoCAD?

To add a curly bracket ({}) in AutoCAD, you can use the following steps:

1. Open your AutoCAD drawing or create a new one.
2. Activate the Text tool by clicking on the “Text” icon in the Home tab or using the shortcut

command “Text” or “DTEXT.”
3. Position the cursor where you want to insert the curly bracket in your drawing.
4. On the keyboard, press the “{” key to insert the opening curly bracket. Then, press the “}” key to

insert the closing curly bracket.
5. Adjust the size, position, and formatting properties of the curly brackets using the text formatting

options available in the AutoCAD text editor.
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6. Once you’re satisfied with the position and properties of the curly brackets, save your AutoCAD
drawing to retain the changes made.

13. How do you add an elevation in AutoCAD?

To add an elevation in AutoCAD, you can use the following steps:

1. Open your AutoCAD drawing or create a new one.
2. Access the “Annotate” or “Home” tab in the AutoCAD ribbon menu.
3. Look for the “Elevation” or “Spot Elevation” tool within the tab.
4. Click on the tool to activate it.
5. Specify the point in your drawing where you want to add the elevation. This point represents the

location for which you want to display the elevation value.
6. AutoCAD will prompt you to select the object or points for which you want to determine the

elevation. You can choose existing objects or specify points on the drawing.
7. Once you’ve selected the desired objects or points, AutoCAD will calculate the elevation values

and display them at the specified location.
8. You can adjust the appearance, units, and other properties of the elevation values using the

settings available in the elevation tool.
9. Save your AutoCAD drawing to retain the changes made.

14. What are surface finish symbols?

Surface finish symbols are graphical representations used in technical drawings to communicate the
desired texture, smoothness, or appearance of a surface. These symbols provide important information
to manufacturers, engineers, or other stakeholders involved in the production or inspection of
components.

Surface finish symbols are typically added to drawings using standardized conventions, such as ISO,
ASME, or DIN standards. These symbols vary in appearance and can include elements like geometric
shapes, letters, numbers, and additional markings or specifications.

Common surface finish symbols include representations for roughness (Ra or Rz values), machining
processes (such as grinding, milling, or turning), surface texture (smooth, polished, or textured), and
welding joints.

15. What are the types of finishing techniques?

There are various types of finishing techniques used to achieve specific surface qualities or
appearances. Some common types of finishing techniques include:

Grinding: This technique uses abrasive materials to remove material from the surface, resulting
in a smooth and precise finish.
Polishing: Polishing involves the use of abrasives and polishing compounds to create a
reflective and smooth surface.
Buffing: Buffing uses a rotating wheel or pad with polishing compounds to produce a high-gloss
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surface.
Painting: Painting is a finishing technique that involves applying a layer of paint or coating to the
surface to enhance its appearance and provide protection.
Plating: Plating is a process where a layer of metal is deposited onto the surface to improve its
aesthetics, corrosion resistance, or conductivity.
Anodizing: Anodizing is an electrochemical process that creates a durable and corrosion-
resistant oxide layer on the surface of aluminum.
Powder Coating: Powder coating involves applying a dry powder to the surface, which is then
heated to form a durable and attractive coating.
Electroplating: Electroplating uses an electrolytic process to deposit a layer of metal onto the
surface, improving its appearance and durability.
Heat Treatment: Heat treatment techniques, such as annealing or tempering, alter the properties
of the surface by heating and cooling, resulting in improved hardness, strength, or ductility.

Conclusion

By following the steps outlined in this article, you can easily add surface finish symbols in AutoCAD to
enhance the clarity and communication of your technical drawings. Remember to choose the
appropriate symbol, specify the desired parameters, and follow industry standards to ensure accurate
representation of surface finishes. With this knowledge, you can create professional drawings that
effectively convey surface finish requirements.
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